
BIAB v7.1.2 – 29 January 2012

This is a very minor revision of BIAB.

Added the capability, for Mass Start Competitions, to force the allocation of specific bib numbers to 
specific competitors, in addition to the random allocation of bibs that already existed.

Changed the way that the names of Competitions (e.g. Men's 20km Individual) are assembled, to allow 
easy identification of Air Rifle Competitions, by adding "(AR)" to the competition title.

Fixed an issue in the Clubs database in which, under certain circumstances, you might encounter an 
error when you try to create a new Club/Division after having preserved data from a previous version of 
BIAB.

Updated the Aggregate Data from Cadet Competitions capability so that the points that are earned are 
also aggregated, in addition to the aggregation of competition times.

Changed the names of some scripts, inserted dialog boxes within those scripts to better explain their 
functions and actions, and updated the names of some of the provided associated files, all related to 
Importing the Names of Competitors from MS Excel files, as part of a distributed Competitor Entry/
Registration system.

Made some cosmetic changes to the Agenda for Team Captains' Meetings.

Updated the list of Clubs and Divisions to reflect better those on the Biathlon Canada web site.

BIAB v7.1.1 – 14 January 2012

This is a very minor revision of BIAB.

Fixed a problem with the application of the Cadet Rules for the suggested class for a competitor, and 
improved the means by which the Cadet Rules category change date was entered into BIAB.

BIAB v7.1.0 – 6 January 2012

This is a minor revision of BIAB, notwithstanding the way the version number has been incremented.

Added, as a script in the Main File that is run from the Scripts Menu, the ability to import the names, 
gender and date-of-birth of Divisional Athletes, Coaches and Officials, from the data in the Biathlon 
Canada On-Line membership database.  You will need to contact Biathlon Canada to arrange access 
to the data ( information@biathloncanada.ca ), then, when needed, you run the Script in the Main File 
to import the basic registration data into BIAB, and as part of that process, type-in or Paste the URL 
that provides data access.

Added, under Main File > Enter Data > Preferences > Miscellaneous the ability to set the default entries 
used in new records for the type of rifle for competitions (options are 'None', '.22 Rifle' and 'Air Rifle), 
and the default language that is specified for any new Clubs/Divisions that are created (options are 
'English' and 'Français').

Changed, in Main File > Enter Data > Dates > Competitions, the sort order in which competitions on that 
date are shown.  The sequence of the competitions is now reflected, rather than showing them in 
alphabetic order.

Changed the format for exported MS Excel files from .xls to .xlsx (Office 2007 and later versions) to 
update to the more recent standard, and to ensure continued operability of the Macintosh version of 
BIAB if it is run under Mac OSX v10.7 (Lion).
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Fixed a minor problem on printed reports of Zeroing Lane assignments which, on rare occasions, 
caused some text to appear in the wrong language.

Corrected minor problems on the Penalty Loop Consolidation Sheet, renamed it to the Penalty Loop 
Team Data Reconciliation Form, and relocated it so that it is now available from the Competition File, 
rather than from the Forms page in BIAB's main file.  Since the form is now generated from within the 
Competition File it already has the correct Bib Numbers for that particular set of competitions.

The Range and Penalty Loop Communicator form, and the Penalty Loop Recording Team Data 
Reconciliation Form are now printable in either French or English.

Added the ability, under Main File > Enter Data > Preferences > Miscellaneous, to change the date that 
is used as the basis of calculating the class of a competitor when using the Cadet Rules.

Fixed a minor problem with the Range/Penalty Loop Communicator Form to correct the problem that 
arose if you printed it after you had created results, in which the sort order of the Bib Number was 
incorrect.

Some cosmetic changes have been made to the Main File > Enter Data > Trails screen.

BIAB v7.0.9 – 10 August 2011

This is a minor revision of BIAB.  The significant and generous contributions of Serge Le Guellec, to 
help  me make all the Reports and Forms available in both French or English, are hereby 
acknowledged.  Serge;  Merci mille fois!

Added a new capability and associated Report.  When you are entering the details for a Club or 
Division, you can now enter local contact details (contact name, phone number, and address) and 
create a report listing this detail for all the Teams/Divisions that have entered athletes in your 
competitions.  This will allow you to print and distribute a contact list to help communicate with the 
visiting Teams/Divisions, and assist them in communicating with each other.

Added flexibility to the choice of titles/designations for the members of the Competition Jury, so that the 
new IBU rules (2 elected members and the Course Referee plus the TD and Competition Chief) or the 
customary practise for Canada (three elected members plus the TD and Competition Chief) can be 
selected for display on Reports and Daily Agendas.

Added the capability to use BIAB to aggregate/maintain a running total of all the CWG Team Points 
that are used to determine Provincial/Territorial results at the Canada Winter Games.  BIAB now fully 
supports on-command the gathering and reporting of these points as they are accumulated during the 
Games. You simply need to change one of BIAB's default points lists (in Main File > Enter Data > 
Preferences) to match the CWG's scale of points.

Added the capability to force a particular Start Order of Teams in a Relay or other team competition.  
This facilitates the process of creating a competition file with the relay team order-of-start based upon 
the results of a previous competition, or perhaps upon overall championship points.

Improved the processes used to import data from previous versions of BIAB, using the Transfer Data 
from Previous Version of BIAB script found in the Main File.  Upon transfer of data the records in the 
data tables are re-serialized, and the relationships of data from one table to another are modified to 
reflect the re-serialization.

Added the ability to select a preferred language of contact for each Club/Division, which then enables 
BIAB to generate written correspondence to be generated in that designated language for that Club/
Division.  This supports creating Grouping Questionnaires and Relay Entry Questionnaires in French for 
Teams/Divisions for whom a Questionnaire in French is appropriate, and in English for others.  In order 
to do this you can specify either French or English (the default) as the Language of Contact for any 



Club/Division.

All reports that BIAB creates to facilitate the verification of the data that have been entered into the 
databases can now be selectively produced in either English or French.

The Bib Sorting Sheet is now produced in either English or French, according to the language selection 
that you make when Start Lists and Results are produced. 

Added the capability to produce all the Forms, e.g. Range, Course and Penalty Loop data acquisition 
forms, in either French or English versions.

For a network of Summit Timers, added the capability to change the initial time settings on the timer to 
any time that you specify, rather than only resetting the timers to 0:00:00.0 hours.

Fixed a bug, that affected the sort order of finished Bib Numbers when taking data electronically from a 
timer, which occurred if you were using a Chronomix, Alge, Tag Heuer, single Summit, or TimeTech USA 
timer.  This bug did not affect data received with a network of Summit Timers.

Fixed a couple of bugs, associated with Zeroing Lane Allocations and with Questionnaires for Relay 
Teams, that occurred under certain sets of circumstances.

Made a number of minor cosmetic changes to screens and to processes in both the Main File and in 
the Competition Files.

BIAB v7.0.8 - 16 January 2011

This is a minor revision of BIAB, but is a bug fix.

This version fixes a bug that caused errors if you tried to print a Start List for a Pursuit competition from 
within the Competition File.  The bug only affected Pursuit competitions.

This version further refines the menus that give you the opportunity to redefine competitors from the 
form view that is contained in a competition file.  Now the Type of Competition drop-down menu is linked 
to and limits the choices in the Competition Name drop-down menu, which, in turn, is linked to and limits 
the choices of Competitors from the Competitor Name drop-down menu.

A number of cosmetic changes have been made within the processes that display Start Lists.  These 
changes reduce the distractive activity that used to occur on-screen as Start Lists were created.

BIAB v7.0.7 – 2 January 2011

This is a minor revision of BIAB.

Changes have been made to the Cadet competition aggregation feature at the request of the Cadet 
Eastern Region and the Cadet Central Region.

Excel files, showing the aggregation that has been completed to that point, can be produced 
at any time, and they can be produced either from within a competition file, or from the Main 
File.JGL, using the new scripts in the Scripts Menu.

The Second Qualification Competition can be an individual entry competition, such as a Sprint 
or an Individual, or a team competition, such as a Relay.  In previous versions of BIAB the 
second competition had to be a Relay.

Capability has been added, by way of a script accessible from the Scripts Menu in the Main File.JGL, to 
produce an Excel file that contains the Club/Division information, as well as the actual names of the 
Competitions, so that they can be pasted into the "BIAB Team Entries Template" so that registration 



can be completed by having the clubs or divisions return to you Excel files in which they have provided 
you with the necessary registration information.

Additional data validation routines have been added to the competition files, specifically on the entry of 
range data. Now, when entering range data manually in the list view, or from Summit Timers, if the data 
string contains more than one digit, the background colour of the field turns RED to indicate to the 
operator that the data needs to be fixed.

Cosmetic changes have been made to the screen in which you select the options for Draws for Pursuit 
competitions.

BIAB v7.0.6 – 19 November 2010

This is a minor revision of BIAB.

Fixed two non-working buttons that were supposed to change the sort-order of listed Relay and Patrol 
Teams.

Corrected some errors in the French text that was added in v7.0.4.  If you are aware of other errors, or 
better translations, please let me know and I will be happy to change them.

Added on the Main File>Enter Data>Preferences>Miscellaneous section an option for turning the 
ToolTips feature on or off.  This capability was added for those who have grown tired of ToolTips being 
displayed whenever you manoeuvre around the application.  This control also available by clicking the 
ToolTips On/ToolTips Off text that appears on some of the screen views.

BIAB is now based upon the latest version of FileMaker Pro, which is 11.0v2.

BIAB v7.0.5 - 5 March 2010

This is a very minor revision of BIAB.

Changed the way that BIAB creates results, so that, if you happen to create two different competitions 
that have identical names, you can still create separate results, rather than having the results of those 
two competition intermixed.  This will have no affect upon most users.

Added to the description of the Trails, a field for Height Difference on each trail.

Changed the Final Results Cover Sheet to better reflect the information required in the IBU rules and 
current practise.

BIAB v7.0.4 – 27 January 2010

This is a minor revision of BIAB.

Added options when dealing with Unqualified Entries in Pursuit Competitions.  BIAB now clearly 
distinguishes between allowing entry into Pursuit Competitions for Competitors who have not completed 
the Qualifying Competition, and whether such Unqualified entries should be treated as 'unofficial' 
entries with no status, or to allow full status to such entries.  The ToolTips associated with these choices 
have been updated, to provide better guidance.  Finally, you can now, from the Form View in the 
Competition File, declare any Pursuit Competitor to be "Official" or "<unofficial>.  This last capability 
allows you to deal properly with last minute entries that might be added to the Competition File after the 
Draw.

Changed the scripts used to process Finish Times entered from the keyboard, so that data will be 
properly accepted from both English and French (Canada) system settings on the host computer.  This 
means that either the comma (",") or the period (".") can be used to represent the decimal point in 



Finish Times that are entered through the keyboard or a keypad.

Changed the Agenda-for-the-Team-Captains'-Meeting capability so that you can now produce the 
Agenda in your choice of English or French.

Changed the Daily Activities Poster so that it can now be produced in both French and English.  In 
association with this made a number of cosmetic changes and added new fields for French text to the 
form views of the Main File>Enter Data>Dates.

Changed, in Main File>Enter Data>Dates the buttons that facilitate copying data, such as the names of 
Jury Members, from one record to another.  Now there is one button per page that will replicate all the 
fields that appear in the tabbed portion of the screen.

Added an option, when working with a Network of Summit Timers, that gives you options when using 
one of the timers to enter Penalty Loop data.  You can now enter the Bib Number, a space, and the 
Number of Loops that were skied, or use the existing option in which the Bib Number of each 
competitor is entered every time that he/she passes the observation point on the Penalty Loop.  The 
new option makes Penalty Loop entry almost the same as the entry of shooting results.

Added a new form that can be used to consolidate the data from the Recording Teams on the Penalty 
Loop.

Corrected the routine from processing data from a single Summit Timer so that the software properly 
counts and displays the number of records that have been received from the timer.  This was a 
cosmetic issue that only affected users of single Summit Timers.

Corrected a minor issue with the resetting of the identification of the Timer Device for a single Summit 
Timer.  The software now always expects that timer to be Device #1.

Corrected a minor problem with display seen in the selection field for Concurrent Results, and with the 
Event Title that appeared on the Concurrent Results.

Changed some of the warning text and ToolTips that are related to the deletion of data entries that are 
shown within Portals on a page.  Any entry within a Portal must be deleted by using the button that has 
been provided for that purpose.  The "Delete Record" button that is within the standard Header on 
each screen will delete the record that is associated with the screen, not the entry that contained within 
the Portal.  This would not be the outcome that you were seeking were you to attempt to use it for this 
purpose.

Updated the script that is used to import records from previous versions of BIAB, to ensure that the 
version number of BIAB cannot be inadvertently changed during this process.

Made cosmetic changes to several views that appear in Competition Files, to make it easier to read 
some of the header information.

Made cosmetic changes to several of the Main File.JGL screens associated with Pursuit Draws.

BIAB v7.0.3 – 21 December 2009

This is a minor revision of BIAB.

Changed the way that BIAB validates range data that has been entered into a competition file using 
the keyboard.  BIAB now immediately notifies you if you incorrectly enter a non-numerical value, or a 
value greater than 5.  It will no longer allow you to accidentally enter digits twice, such as 22 instead of 
2.  You have the option of using the validation, or you can turn it off if you find it bothersome.

In list views of data, in most parts of BIAB, I have added extra highlights so that the record that is 



currently selected, and active, is more obvious to you.

Fixed an issue in which, if you were electronically importing range data from a target system or a Summit 
Timer, you could get an error message if you copied and process some of the shooting data before it 
had all been received within BIAB.

BIAB v7.0.2 – 7 December 2009

This is a minor revision of BIAB.

The list of trails to follow, which can be created from within a Competition File and which is intended to 
be displayed at the Start Line to assist Competitors, now is available in either French or English, 
depending upon the setting chosen for the language of Start Lists and Results.

A new button has been added to the screen within the Competition File that is used to monitor timer 
data coming from Summit Timers at the Finish Line.  This button will allow you to force a re-sort, into 
ascending order of bib number, of the bib numbers that have been entered into BIAB as having 
finished.

In the spreadsheet that shows the aggregated results of Cadet qualifying competitions, the gender of 
the competitor is now included, and the order in which the fields are listed has been modified.

Minor cosmetic changes have been made to the appearance of some of the screens that show data 
that has been collected from electronic timing systems.

BIAB v7.0.1  – 26 Sep 2009

This is a major revision of BIAB.  The interface that you see in a Competition File has been completely 
changed.  BIAB now uses the same graphic interface model throughout its structure, whether you are 
just starting to set up for an event, or are in the middle of gathering results data during a competition.  
Navigation within the Competition File is much easier and more direct with the new interface.  In 
addition, I have streamlined the code behind many of the processes, including Draws, and Results 
creation, making them faster.

BIAB can now utilize two different Serial Ports at the same time.  This means that BIAB can connect 
directly to electronic target systems, such as the Kurvinen Electronic System in Canmore or the HoRa 
2000e system in Whistler Olympic Park, while using the other Serial Port to connect to a network of 
Summit timers.

BIAB can now deal with the standard Relay Competition output of the HoRa 2000e target system, so 
that it no longer requires a special work-around set-up to the HoRa software.  BIAB now will infer the 
colour of the relay bib from the volume of data that has been received from the HoRa system, so that 
there is no need to enter an extra number as part of the Competitor’s bib number to indicate the colour 
of the bib (a consequence of which is that the HoRa software then loses some it its utility).

All the interfaces used for setting up electronic timers, together with the code that is used for processing 
electronic data from timers and from timing systems, have been extensively re-vamped to make it easier 
to navigate within BIAB, and to reduce processing times.  It is now much easier to monitor and confirm 
data coming from an electronic timer, and to copy the electronically received data into the rest of the 
competition file, which you must do in order to create results.

BIAB now uses a dedicated, but separate and continuously visible, window to allow you to control the 
flow of data from an electronic timing system.  You can interrupt and resume the flow of data at any 
time, and, provided you do not grossly extend the interruption, the data that was generated during the 
period that the flow was interrupted will still be available to you as soon as you resume accumulation of 
the data.



The processes used to amalgamate the performance results achieved during a number of Cadet 
competitions, to aid in Cadet Region representational team selection processes, have been improved 
and expanded.  You are now permitted to have an unlimited number of individual and relay qualifying 
competitions, and the data from those competitions is now directly transferred during the amalgamation 
process, without the use of intermediate files.  Previously, the user was forced to manually manipulate 
data contained in the intermediate files, if it was necessary to hold more than one qualifying competition 
of each type.

You can now, using a Script Menu command in a Competition File, produce an electronic version of 
results data, with a choice of two file formats:  either as a comma separated values (.csv) file, or as an 
MS Excel worksheet.

I have made extensive changes to the BIAB capability that allows you to create Agendas for Team 
Captain’s Meetings.  You now have total control over the Agenda items, including having a hierarchy of 
items, and can add brief remarks to any individual Agenda item.

The number of Classes of Competitors that can be associated with any Competition Class which has 
the words ‘Mixed’, ‘Unit’ or ‘Composite’ in its title, has been increased from 4 to 8, which will properly 
support the needs of Mixed Relays, as well as other competitions.  Within BIAB the meaning of these 
terms is:  ‘Mixed’ refers to more than one gender, ‘Composite’ refers to more than one competitor class, 
and ‘Unit’ is normally associated with Cadet units, indicating all competitors are from the same unit.  In 
terms of usage this capability effectively allows the flexible creation of Classes of Competitors which 
have constituent sub-classes, in which you can have mixtures of ages, genders and other competitor 
attributes.

Some minor changes have been made to some reports and to the way data is displayed, to make BIAB 
more consistent with the emerging standards that are established by the IBU.  In addition, the way that 
times are displayed in Results has been changed, so that, in general, any leading zeros within the time 
are suppressed.

Cadet Youth Male and Cadet Youth Female categories have been added to the selection list of 
available competitor classes, to accommodate the emerging new Cadet Competitor Classes.

The user has been given easier access to the information needed to change the actual names of 
Competitor Classes (Cadets, Mixed, Bantams, Composite, Youth Women, Midgets, etc.) that are used 
within BIAB, within the drop-down menu systems.

Changes were made in the way that BIAB determines the data that is needed to calculate the 
performance percentages that are displayed on results.  This change eliminates the possibility of an 
error in a Pursuit competition, which could have occurred if there were ‘unofficial’ entries that placed 
amongst the top three finishers.

BIAB will now accept up to two different Bib Number look-ups for each transponder that is part of the 
AMB ChipX competitor identification system.  One list is made for normal bibs, and the other is made for 
relay bibs, each linked to the same transponder identifier.  Depending upon the type of bibs normally 
worn for the particular competition, BIAB will automatically use the appropriate list.

If you elect to Display the Draw for any single-start Competition which features a random draw for start 
times (e.g. an Individual or a Sprint), you will see an entirely new display of the Draw, as it progresses.  
The display in now meaningful, in that it depicts the double-random nature of the Draw, as if you were 
conducting it manually.

A large number of cosmetic changes have been made to various screens, and numerous additional 
tool-tips have been incorporated to provide more assistance to the user.  A number of the existing tool-
tips have been updated to clarify and further refine the information presented.

BIAB v6.0.7 – 6 February 2009



Fixed a problem with the display of results in Relay competitions.  The teams are now sorted into the 
correct order.

Fixed the use of keyboard entry of finishing bib numbers, in conjunction with using an electronic timer 
for the finishing time.

BIAB v6.0.6 – 24 January 2009

BIAB is now based upon v10.0 of FileMaker Pro.  This new version contains enhancements which will 
allow additional capability to be built into BIAB.

V6.0.6 contains the new capability of Rapid Data Entry of competition data, which permits the input of 
shooting results and finish times using only the keyboard, rather than in the past when both the mouse 
and the keyboard had to be used in sequence.  For someone who is reasonably accomplished on a 
keyboard the new capability can be much faster, particularly when there are many competitors.

BIAB v6.0.5 – 16 December 2008

Fixed a problem with the names of clubs in v6.0.4 that arose when trying to create more Relay or Patrol 
Teams.

Changed the points tables to update the values for the number of World Cup and Nations Cup points 
that appear on Results so that the points shown are in accordance with the new points allocations 
contained in the September 2008 version of the IBU Handbook.

Added the ability to accept Registration Information that has been inputted over the WWW to the 
Zone4 Registration Web Site, which enables you to have competitor self-registration in Events and 
which can collect registration fees as part of the process.  Any version of Zone4, including the free 
version, can be used, in addition to BIAB, to set up the registration parameters (go to www.zone4.ca for 
more details), but after that has been done, BIAB will import the registration data from a file that has 
been created by Zone4 specifically for this purpose.  The process on importing the data into BIAB will 
identify the Participants, and register them in Competitions, as well as optionally Enter the Registrants in 
Concurrent Events that have been defined within BIAB. This allows for an almost seamless transfer of 
data between Zone4 registration and BIAB, and will greatly reduce the burden of competition 
registration for those Clubs and Divisions which choose to use the Zone4 services.

Added the ability for the user to choose whether the performance percentages shown on BIAB Results 
are calculated solely on the basis of the winner’s time, or whether the percentages are based upon the 
average finish time of the first three finishers.  In the latter case, which is the method normally used by 
Biathlon Canada when it is calculating performance percentages, there must be at least four finishers 
before any percentages are shown on the Results.

Added the capability, WHEN USING A NETWORK OF SUMMIT TIMERS, in a Relay Competition which 
has a finish line that is not in the Handover Zone, to capture Competitor finish data at both locations. 
BIAB will now let you produce results from the electronic data when there is a Summit Timer capturing 
Finish Times and Bib Numbers at the start of the Handover Zone, and from a separate timer (or different 
timing channel) that is capturing Finish Times and Bib Numbers at the Finish Line.

Removed the capability, which was added in v6.0.4, to be able to enter any Device Number for a 
Summit Timer on the Summit Timer Network Setup Screen.  In hindsight, this option made no sense, 
since BIAB will only accept Device Numbers from 1 to 8 inclusive, because of the way timer-originated 
data is processed within BIAB.

BIAB v6.0.4 – 19 May 2008

Added the ability to enter up to four different Adjustment Times for each competitor, and then to have 
BIAB compute a total for these times, and to use that total in computing the results.  In addition, BIAB 
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will automatically create a ‘Remark” that appears in the results, and which lists the separate Adjustment 
Times.  This feature was added at the request of the Cadets who have to deal with many adjustment 
times at local competitions since there is a limited supply of rifles, and Cadets often have  to wait on the 
firing point until a rifle becomes available.

Added features to support the Cadet selection processes in the Regions, in the form of two Scripts, that 
will automatically aggregate the performance data for both individual competitors and team members 
using the results from two different competitions, one being a Relay, and the other being some 
standard form of individual participation competition, such as an Individual, a Sprint, or a Pursuit 
competition.  The aggregated results are returned in two MS Excel spreadsheet files, which can be 
displayed or printed, and in which the data can be further manipulated if needed.  The Scripts are in 
the Competition File, and are run after each of the competitions in the series has been finished, 
including the generation of results. 

Added the capability, when using the Summit Timing Systems DLL as the means to communicate with a 
network of SRT 500/1000 timers, to change the amount of time during which the timers are permitted to 
transmit data after they have been polled by the DLL.  While the manufacturer’s default time, 400 
milliseconds, works fine with ‘real’ Summit timers, it should be changed to a higher value, 1000 
milliseconds is suggested, when a simulated Summit Timer (KES2Summit or HoRa2Summit) is included 
in the network, since the simulated timers do not respond as quickly as a ‘real’ timer.  This feature is 
accessed on the Timer Network Set-Up Screen.

Fixed the routine for processing start times and bib numbers from electronic timers that are triggered by 
a starting gate, or equivalent.  This routine associates a bib number with a timing impulse from the 
starting gate when the timing impulse corresponds to an expected time that is on the start list.  The 
coding in v6.0.3 causes BIAB to go into an endless loop when the last competitor starts.  The routine 
now works correctly.

Corrected an issue with Relay Competitions that caused BIAB not to recognize relay bib numbers (a 
main bib number with a numerical suffix to represent the bib colour) when shooting data was coming 
from Summit timers or from the HoRa target system.

Changed the way that BIAB applies and uses DNS, DNF and DSQ information with teams in Relay 
competitions.  BIAB now associates a Status with each team, as well as with each competitor.  The 
different statuses are now summarized correctly both on the Results and in the cover sheet for Final 
Results.

Fixed several grammatical errors associated with competitor and team status on the cover sheets for 
Final Results.

Changed the way that BIAB portrays a missing time on results, so that you will no longer see “.0” 
appearing when there should simply be a blank space.

Fixed an issue with the sorting order for teams in the results of Relay Competitions, that happened 
when all members of the team had a status other than ‘OK’.

Changed the default settings for a network of Summit Timers, so that ‘Select Bibs’ (or ‘Posting’ of finish 
bib numbers) is now the default setting with Summit Timers.

When completing the setup for a network of Summit Timers, whenever setting Device Numbers, the 
choice of ‘Other” is now available to permit you to input whatever device number that you choose, 
rather than having to comply with the recommended device numbers that are on the pull-down menus.

Made minor cosmetic changes in some of the Data Entry screens, to increase the size of fields to 
display larger numbers, and to properly identify some windows.

Made cosmetic changes to some of the screens associate with Draws, and improved some of the error 



handling routines associated with Draws, so that the user is given better guidance on how to avoid 
making that error the next time.

BIAB v6.0.3 – 27 January 2008

Corrected an elusive problem that occurred when using electronic timing and toggling back and forth 
between the electronic data entry screen and the manual entry screen. Now BIAB will toggle reliably 
between those two modes.

Corrected an issue that occurred when using electronic timing, and entering Relay Bib numbers. The 
function now works properly both when manually entering the bib numbers while getting times from the 
timer, and when entering the bib numbers through the keyboard on a timer. Thanks to John Pierce for 
bringing this issue to my attention.

Made minor changes to try to be more clear within some of the tool tips that give advice on how to use 
Summit Timers and enter bib numbers through their keypads.

Added some extra steps in the process of setting up for electronic timing, so that you can more easily 
ensure that you are connected to the correct serial port on the computer.

BIAB v6.0.2 – 13 January 2008

Corrected a minor error that caused the old software version number to appear within the newer version 
software if you imported data from an older file using the Script ‘Transfer Data from Previous BIAB 
Version.’  Thanks to Daniel Bélanger of the ACBQ for pointing out this error.

Corrected a strange looking error on the screens associated with the competition dates, in which an 
action button appeared on many screens when it should not have been there.

Updated the underlying database software, FileMaker Pro Runtime, to 9.0v3.

Made some minor cosmetic changes to different screens and dialog boxes.

BIAB v6.0.1 – 22 October 2007

Updated the underlying database software, FileMaker Pro Runtime, to 9.0v2, to provide better 
compatibility with Windows Vista.

Modified, based upon information received from Summit Systems, the code that is sent to an attached 
MaxStream XStream modems to change the frequency hopping channel sets (in Summit Terminology, 
the “Modem Network Number”) that the modem will use in its operation.

Made minor changes to the appearance of the screen in the competition file that is used to configure 
networks of Summit Timers.  This includes the ability to look up bib numbers that have been assigned to 
correspond to specific AMB transponders.  Confirmed in limited testing that BIAB will work with Summit 
Timers and the AMB ChipX transponder system to provide identification of competitors.

Introduced the capability to force an order-of-finish of competitors, in the case that two or more have 
the same finish time, but a tie is not acceptable, such as in Mass Start, Pursuit or Relay Competitions.  
Once you have determined that there is a tie that must be resolved, in that competition file, go to the 
form view for the competitors involved, and use the menu provided to specify their placing/order of 
finish.  The forced order-of-finish will appear the next time that results are generated.

Made minor changes to the size of all the windows in Main File.JGL to make more effective use of the 
available screen space.  The windows were slightly reduced in size so that they can be magnified, using 
the tool at the bottom left corner of the FileMaker window.   This should make data visibility much better, 



particularly on lap-tops and computers with intermediate to high pixel count screens.

BIAB v6.0 – 17 August 2007

Changed the way that BIAB calculates the performance percentages for athletes, so that the 
performance percentage compares each competitor to the winner of that competition, rather than to the 
top three finishers as was the case in previous versions of BIAB.  This change was made to conform to 
changes in the Biathlon Canada National Team Program selection requirements so that the calculations 
from BIAB can be used for that purpose.

Updated the version of the Troi Automatisering Serial Plug-In (from v2.5 to v3.0.2) that is used to get 
data from timers that are connected to the serial port on the computer.  The plug-in is now fully licensed 
for the end-user of BiaB, so the end-user has no further expenditures to make in order to use BIAB.  
The upgrade to this version of the plug-in greatly improves the functionality of getting timer data 
electronically.  This version restores to BiaB the capability of continuously receiving data from a single 
timer, regardless of the type of computer or operating system that is being used, without having to 
trigger manually the data acquisition process.  The downside is that the cost of licensing this upgrade 
was over US$1000, and a portion of that cost will be passed on to current and new BIAB licensees, to 
recoup part of the investment made on behalf of the users of this product.

Updated the scripts that access data on Chronomix 737 timers.  Chronomix timers can be used simply 
for start and finish times, or can be used with the optional timer keypad to enter ‘Select’ bib numbers.

Made provision for BIAB to be able to interface with and accept shooting data from the Kurvinen 
Electronic Target System, when it is used in conjunction with Summit Timers on a network of timers.

Changed the way that BIAB calculates Range and Penalty Loop results when these data are coming 
from a Summit Timer network.  The results are now calculated automatically as soon as the data are 
received from the timer.  There is no longer any need to separately initiate the calculation process.

Changed the way that BIAB handles times from a timer that is attached to a starting gate.  Now BIAB 
assumes that the correct Bib Number will start at its assigned time, and if there is a start within the 
allowable margins of that time, then the scheduled bib number started.  If no start happens there is no 
need for manual intervention.  The only time that manual intervention is required is if someone starts 
out of the scheduled sequence.

Added a script to the Main File so that BIAB can import from a text file a look-up table to get the correct 
Bib Number associated with an AMB competitor identification chip. BIAB is now compatible with the 
AMB system provided that it is integrated through a Summit Timer Network, using a serial-port-equipped 
Summit Timer.

Added the capability to conduct Super-Sprint competitions, as defined under the new (2006) IBU Rules.  
The Super-Sprint consists of a Qualifying Competition, followed by a Final Competition, for which you 
must have achieved acceptable performance in the Qualifying Competition to make the cut-off for the 
final.  BIAB will make the draw for both the Qualifying Competition and the Final Competition.

Added the capability, in Pursuit Competitions, to force any class of competitor to start from the first 
starting lane on the starting grid.  This is useful when multiple classes of competitors are starting from 
the same grid at the same time, or in close temporal proximity, so the spectators can easily identify the 
leader at the start.

Updated the version of the BiaB Support Plug-In, to make it more sustainable for the future, and to 
provide a new means of communicating with a network of Summit timers.  BiaB users who use Windows 
now have the option of using the dynamic link library (DLL) developed by Summit systems to 
continuously poll the timer network.  This gives a second reliable means of communicating with a 
network of timers, and will hopefully mean continued compatibility with the timers by permitting the easy 
incorporation of capability changes as they are introduced by Summit Systems.  This capability does not 



work with the Mac OS for obvious reasons.

Made significant changes to the way that BIAB handles data that is received from a network of Summit 
Timers.  These changes greatly enhance the reliability of the system and result in a very significant 
reduction in the number of errors that occur when getting data from the timers on the network.

Changed the options for use with Summit Timers to allow the entry of ‘Select’ Finish Bib Numbers, or to 
use the terminology found in the manual of the Summit Timers, to ‘Post’ Finish Bib Numbers for some 
competitors.

Increased the number of timers that are allowed to comprise a Network of Summit Timers, and changed 
the role of some of the timers.  Up to 8 timers can now be networked, with up to 2 in the Start/Finish 
area, 1 providing Intermediate Times (normally in conjunction with the AMB ChipX identification system), 
up to 4 on the range providing shooting results, and one on the Penalty Loop (normally in conjunction 
with a detector for the AMB ChipX identification system).

Added the capability, under Preferences, to determine and to change the Radio Frequency Sequence 
Set number that is being used by an XStream Radio Modem, the kind of radio modem that is used with 
Summit Wireless Timers.  This capability makes it easier to overcome frequency conflicts with the Summit 
Wireless Timers.

Improved the function that verifies the integrity of the data that has been downloaded from Summit 
Timers.  This allows you to quickly determine that there are no records missing in the sequence of 
records generated by the timer, and that there has been no duplication of records in the database.

Added the capability to edit more easily the listing of the Bib numbers assigned to each of the Start 
Times that comes from a timer that is being triggered as each competitor starts in Single Start 
competitions.

Added the capability to edit more easily, or to type into the database from a separate listing, the Bib 
Numbers of the competitors, as they finish, or after they have finished.

Changed how BIAB reacts to data arriving at the serial port.  In previous versions, except when Summit 
Timer Network was being used, any data from a timer that arrived at a serial port had priority.  This did 
result in the occasional interruption of some other activity, such as entering shooting results, when data 
arrived at the computer.  Starting with v6.0, if you stop monitoring the arrival of data, and go to another 
screen to enter or modify data, data is queued-up (accumulated) at the serial port, and held there until 
you return to the data monitoring screen.  At that point all the data that has been accumulated in the 
queue will be processed.  However, in order for this to happen, you MUST use the buttons provided 
within BIAB to change from one screen view to the other.

Changed the format of the results of Pursuit competitions, so that the finish time is not shown, since it 
has been causing confusion in Pursuit competitions that have handicap times from the previous 
competition, but which attempt to reduce that gap to allow both spectators and competitors to enjoy 
more fully the competition.

Corrected an error in the number of World Cup points that are allocated for sixth place and below.

Added, within the Preferences, two more sets of points that are shown on results, so that BiaB now 
contains World Cup Points, Nations Cup Points, and Relay Nations Cup Points.  You select, on the 
Preferences screen for Points, which of the three sets of points will appear on the results.  You may edit 
all three of the points sets to use points allocations which best meet your needs.

Modified the Questionnaires used to solicit Entry/Grouping information, so that there is only one 
questionnaire per team, instead of one for each class of competitor.  Made minor changes to the 
screens associated with generating the questionnaires and for entering the group numbers for the 
competitors.



Corrected an error in the draw process for Relay and Patrol Teams, which resulted in the wrong order of 
the teams when groups were used.

Fixed a problem that occasionally occurred when using electronic time, and no longer being able to 
move easily between the electronic data entry screen and the manual data entry screen.

Made a number of cosmetic changes in various parts of the programme, to make instructions more 
meaningful and visible, including the incorporation of some new mouse-over tool-tips.

BIAB v5.1.4 – 3 December 2006

Incorporated within BIAB the capability to create Start Lists and Results in either French or English.

The software remains a program that is written in English, and which produces the majority of its output 
in English, but you can input event and concurrent event titles, and other basic terminology in French 
and English, and then select the language that you want when you print Start Lists, or any of the 
several formats of results that BiaB will create.

The French terminology is accessible by selecting the appropriate layout, and by using the menu on the 
upper left which shows the layouts, the user can gain access to the database containing the French 
terminology, and make changes to the terminology to better suit local conditions or custom, eg the 
French equivalent of ‘pre-junior boys’ is current set as <<garcons cadets>>, but you can change that 
translation if you wish.

Made some changes to the code used to conduct error checking on data being received from Summit 
Timers.  These changes should make the process more reliable, and reduce the instances of errors 
happening within the data transfer processes.

For Summit Timers, when you are viewing the data that has been downloaded from the individual 
timers, there is now a button that will run a Very, Very Rudimentary script that will scan the records that 
have been downloaded, and which will alert you about any duplicate records that it finds, and if a timer 
record is missing from the normal sequence.  I caution you that this is a very rudimentary capability, but 
it does assist you in quickly examining the data that have come from the timer.

This version of BiaB has been created in the latest release of FileMaker, v8.5, which features enhanced 
performance in Windows and which will run in Intel-native mode, with greatly enhanced performance, on 
a new Macintosh that has an Intel processor.

BIABv5.1.3 – 1 April 2006

Changed the terminology for the designation of some of the Club-Level Pursuit Competitions.  They are 
now called ‘Normalized’ rather than ‘Leveled’ when the start interval is short, and when the handicap 
time is shortened or eliminated.

Added the ability to selectively display on Start Lists and on Results for Pursuit Competitions whether 
the Competitor is an ‘Unofficial’ Competitor, which indicates that he/she did not compete in the 
qualifying competition, and is not eligible for prizes or placement within the competition.

Added the ability, invoked with a Script from within a Competition File, of adding to that file the data 
from another competition that has been completed.  In this way, the larger, combined file can be used 
as the “Qualifying Competition” file for a Pursuit Competition, for which the qualifying competition was 
really two separate files, such as a file from the morning and one from the afternoon.  The resultant 
Competition File for the Pursuit Competition will have all the competitors listed in the correct starting 
sequence, regardless of which of the original competition files that they were in. Before combining files 
you should ensure that you have created back-up copies of the files, and that each of the files has 
been used to produce results, so that each will contain the place attained by the athlete, and the time 
that each was behind the winner in each of the competition classes.



Fixed an error in which, from within a Competition File, you could experience difficulty in changing the 
identification of the competitor who is associated with a specific Bib Number.

Fixed an error in the script associated with creating a Grouping Questionnaire, in which, under some 
circumstances, competitors from more than one class of competitor would be listed on the same 
Grouping Questionnaire.

Made cosmetic changes to a number of reports, including increasing the space allowable for Bib 
Numbers on lists and reports, so there is more room to show a longer abbreviation of the colour of bibs 
issued to the leaders in the North American Cup series.  I also increased the amount of space available 
for titles at the top of forms so that longer organizational names will print properly.

Made cosmetic changes to a number of screens to improve their readability.  Changed the order of the 
selection menus used for Draws.  The menu to select the Type of Competition is now consistently on 
the left, with the ‘Select Sub-Set of Records’ button immediately adjacent to the selection menu.

BIABv5.1.2 – 18 March 2006

Made a number of cosmetic changes to various screens and reports to improve their appearance, and 
to change the way that the data is sorted to make the report more useful.

Made a number of mostly cosmetic changes in the form view in competition files, to reduce clutter.  At 
the same time a number of Tool-Tips were added to provide help.

Made several changes to the process of creating Start Lists for the Mass Start competitions.  The 
proper start time, when there are Group Starts, is now calculated.  In addition, the order of sort for the 
Bib Sorting List has been changed.

Added, at the bottom of the screens used to select the competitors to be included in the Draw, the 
ability to preview and print a report that can be posted, or given to Team Captains, to confirm the data 
that is about to be used for the Draw.

Added, to the Forms screen, the ability to make Range Stickers, using Avery 5161 labels.  This is the 
system used in the USBA to keep track of range results, by placing the sticker on a large, preformatted 
sheet to paper, to give an overview of what has happened on the range.

Fixed a problem with acquiring Competitor’s Bib Numbers with a network of Summit SRT 1000 Timers.  
This problem did not affect any other type of electronic timer.

Several users have experienced difficulty with BIAB because they were saving Competition Files into 
directories other than the one that contains the BIAB application.  If you do that BIAB does not work 
properly because the Competition File cannot find the Main File.JGL, which must be readily accessible 
for related data, such as the names of the competitors.  I therefore changed the scripts that are used, 
as part of the draw process, to save the Competition File.  You now have no choice:  BIAB will only 
save Competition Files in the directory that contains the BIAB application.  However, be warned that, in 
order to achieve this end, during the draw process, BIAB will now over-write any file that has an 
identical file name AND which is in the same folder/directory as the BIAB application.

Modified slightly the scripts used to create a back-up file, and then to transfer the data into a new 
version of BIAB.  More data is now transferred, and the process is more robust.

Fixed an obscure error that occasionally occurred in which, after a Draw, the Competition File appeared 
to be for a Team Aggregate competition, when some other category of competition had been chosen.

BIABv5.1.1 - 22 February 2006

Fixed a problem In v5.1.0 In which the type of rifle was Inadvertently taken Into account In the draw 



process, without the knowledge of the user.  This has been corrected.

BIAB v5.1.0  – 17 February 2006

Added the capability to designate competitions for either .22 Rifle, or for Air Rifle, when  the competition 
is being defined.  This feature is then used to allow you to assign competitors to separate zeroing lanes 
for .22 Riles and for Air Rifles.

Changed the display of sponsorship logos on the results of Concurrent Events so that the logo of the 
sponsor/sanctioning organization for each Concurrent Event is shown at the top of the Concurrent 
Competition results.

Fixed a minor issue that occurred after having updated a new version of BIAB from a previous version.  
Now all the records in each of the databases are shown, rather than just the found set.

Made some minor changes to the screens used to define competitions, to make the text more readable.

Reworked the scripts used with a Network of Summit SR1000 timers to count the number of Targets 
Missed on the range, and the number of  Penalty Loops completed.

Reworked the scripts used with a Summit SRT1000 Network to transfer electronic data that has been 
received and processed into the Competition File.  A change was made in the way that Range data is 
transferred, such that the only range data that is transferred is for those competitors for whom data has 
been gathered through the Summit Timers.  Range performance data, which already exists in the 
Competition file, is not overwritten unless it has been gathered from one of the Summit Timers.

Fixed a problem  of duplicate and missing entries for Summit Timers.  This issue arose when there was 
an error in computing a check-sum for a data packet from a Summit Timer.  When there was an error, 
the packet that contained the error was not retransmitted, but other packets were, which caused 
duplicate entries.

Changed the way that the user interacts with BIAB when downloading data from a Network of Summit 
Timers.  When using a Network of Summit Timers, the user must now deliberately poll each timer in 
order to initiate a data download.  However, a new capability has been added in which the user can 
command BIAB to repeatedly and automatically poll in sequence all Summit Timers on the network, 
downloading data from each at 3 second intervals.  This process works in the foreground, so no other 
activity can take place while it is on-going, but it takes care of the routine of getting data from the 
timers.   An option has been created in the Preferences, in the Main File, so that you can change the 
interval at which BIAB polls the timers.  The default setting is one timer every two seconds, but you may 
need to change this to get more reliable operation.  Otherwise, the interface for working with the data 
remains unchanged.

BIAB v5.0.8 – 8 January 2006

Added the capability to create a Club-Rules Pursuit Competition that has a variable standardized start 
interval, the order of start based upon a qualifying competition, but which does not handicap the 
Competitors who did not finish first in their class in the Qualifying Competition.

Slightly changed the Start List for Pursuit Competitions to improve its appearance.

Fixed a problem that arose when trying to generate Summary Results when and if, within a Competition 
File, after the draw one changed the Competition Class of a sole last Competitor, it  then caused the 
behind time in the preceding class of competitor to be incorrect under some circumstances.  (This 
problem didn’t arise very often!)

Modified the routines for processing Range and Penalty Loop data from Summit SRT 1000 timers so 
that Relay Bib numbers can be entered numerically, using 1, 2, 3, and 4 to represent Red, Green, 



Yellow and Blue, as an additional digit appended to the Bib Number.  For example, Bib #22 Green is 
entered as 222.

Made some minor appearance tweaks to some of the screens used for gathering data from Summit 
Timers, including some additional ToolTip explanations.

BIAB v5.0.7 - 6 January 2006

Fixed a problem that only existed when using electronic timing, AND if more than one set of 
competitions was being held on the same day.  Under these circumstances the file for the morning 
would have the wrong bib number sequence appear on the screens associated with the electronic 
timing.

Modified the formatting for kes.txt to reduce it by one column in the data listing.

Changed the default setting for a SRT1000 network to expect, as the default, that finishing bib 
numbers would be entered from one of the Summit SRT1000 timers, rather than through the computer 
key board.

BIAB v5.0.6 – 3 January 2006 

Added support for the Kurvinen Electronic System  (KES) for scoring targets.  This modified the 
competition file by adding scripts to create a ‘kes.txt’ file to help configure the KES system, and added 
the capability to export and import range data to BIAB.

Fixed the ‘Import from an Excel Spreadsheet’ function which appears not to have worked in v5 because 
on an error that I made elsewhere in the application.   Thanks to John Pierce for pointing this one out.

Fixed the script that assigned each competitor to the Concurrent Events that had been specified for 
her/his Club/Division.

Made some ‘tweaks’ to the headers that appear in a number of the print-outs in the Prepare for Draws 
section, to better accommodate lengthy Event Titles on the printout, so the text is less likely to be 
truncated by the space limitation.

Made some minor ‘tweaks’ to the appearance of some items in the Main File.

BIAB v5.0.5 – 20 December 2005

Fixed an error that appeared when attempting to assign competitors to Groups.  The choice of adding a 
competitor to Group #1 is now available.

Updated the Runtime version of FileMaker from 8v1 to 8v2, as released by FileMaker.

BIAB v5.0.4 – 13 December 2005

Added the capability to import data from a previous version of BIAB, so that the process of upgrading 
to a more recent version of BIAB does not mean a lot of work on behalf of the user, particularly when 
she/he has already entered a lot of data for an upcoming Event.  A script named “Transfer Data from 
Previous Version” appears on the Scripts menu, and it transfers all the data.  It provides instructions for 
its use.

Added the ability to create a back-up file of the main databases (the Main File.JGL database) which  is 
automatically named “Old Main File.JGL”  This same file can be used with an updated version of BIAB 
as the source for the data that can be transferred to the new version.

Added (or rather reinserted since it was in v4) the ability to specify a custom distance for a competition, 



using the “Other …” option on the pop-up menu choice for distance, when you input the parameters of 
a competition.

BIAB v5.0.3 – 6 December 2005

Fixed an error in the competition file, in the form view of the competition, which became obvious if you 
tried to change the Type of Competition because the drop down menu did not offer proper choices.

Fixed missing data errors on several of the data confirmation reports in the competition file.

Revised all printed reports to ensure that they use only the Arial font.  Hopefully this will alleviate some 
of the printing issues that some users have been experiencing.

BIAB v5.0.2 - 5 December 2005

Fixed an error which occurred if you conducted a Zeroing Lane Assignment without first having selected 
a sub-set of competitors to whom to assign zeroing lanes.  If you took that action the software took you 
to a screen from which there was no easy return to familiar screens in the application.

Changed the algorithm used for the allocation of zeroing lanes to selected competitors.  The allocation 
of independent competitors to lanes now works as intended, so that true 'independents' are spread 
amongst the existing teams that do not have enough competitors to reach the maximum capacity of the 
zeroing lanes that have been assigned to them.  This way those coaches can assist the independent 
competitors.

BIAB v5.0.1  -- 30 November 2005

Fixed an issue identified in v5.0.0 with the use of BIAB with the ALGE Timy Timer.  The software would 
not communicate properly with the timer, and would cause a system lock-up.  Although I received no 
reports of errors with the ALGE 8001, TAG HEUER CP520 or the Chronomix 737 timers, they would 
likely have exhibited similar issues.  I have not had the opportunity to test any of these timers with v5 of 
BiaB.  However, should the issue be there, it should have been fixed in this current version.

Corrected an error on the Set-Up screen for those timers listed above that asked for the selection of a 
Serial Port, when this selection was not required.

Fixed cosmetic issues on a number of screens, in which the displayed text was truncated.

Added more Tool-Tip help in various places.

Note:  The issues noted above did not occur with either the Summit SRT 1000 or the TimeTech USA 
Sprint 8 timers, which I did have available to test with BIAB v5 prior to its release. 

BIAB v5.0.0 – 27 November 2005

Major Capability Change

BIAB has been totally re-written, with a complete change of the user interface for the basic setup, the 
addition of a number of new features and enhancements to capabilities that had previously existed, 
and the removal of a couple of features that hadn’t been used very much.  The new interface is a 
series of capabilities organized into a hierarchical menu structure, with features that are selected in a 
similar fashion to navigating an internet web site.  The interface change means that much more can be 
accomplished with fewer mouse clicks and keystrokes.   BIAB v5 uses the latest version of FileMaker 
Pro, v8.0; the improvements in which have permitted much of the capability enhancement.

BIAB v5 is restricted to the operating systems on which it will run.  You must have Windows 2000 SP4 
or later or Windows XP SP2 or later.  BIAB v5 will not run under earlier versions of Windows.  On a 



Macintosh you must have OS X v 10.3.9 or later for BIAB to run.  BIAB v4 will continue to be available 
for those who have older operating systems on their computers, but that version will only receive 
minimum maintenance from now on.

BIAB v5 is being released without documentation, since the existing documentation has not yet been 
updated to match this wholly new version.

BIAB v5 will handle two new types of Competition, which are the Pursuit Format, and the Cadet Patrol.  
The former has been included to support the Biathlon Canada hosting policy for 2005/2006, and uses 
the format of a Pursuit Competition, but instead of a qualifying competition, incorporates a random-draw 
single start, using standard intervals.  The other type is the standard Cadet Patrol Competition, which 
has not been supported in previous versions of BIAB.  BIAB v5 will no longer support the entry of ski 
times -  all competition time entries must be finish times and actual start times.  In addition, BIAB v5 will 
no longer produce results in HTML format, a feature in previous versions.

BIAB v5 now permits multiple competitor starts, allows for bibs to be missing from bib sets, can 
automatically associate independent competitors with a particular club/division for zeroing lane 
assignment, uses a new algorithm for zeroing lane assignment that gives better automatic results, has a 
more logical process for conducting draws, supports gathering contact information about participants, 
include keeping a copy of digitized photos of competitors, allows for easier verification of data during 
entry, incorporates on-screen help, in  the form of tool-tip explanations of data or screens when the 
mouse cursor is hovered over a particular area of the screen, and many other changes, which are too 
numerous to mention.

BIAB v5’s capability to use data directly from electronic timing devices remains largely the same as the 
last iteration of v4 of BIAB.  BIAB v5 will work with single timers from ALGE, TAG HEUER, Chronomix, 
TimeTech USA and Summit Electronic Systems.  It will also work with a network of up to

 six Summit SRT 1000 timers, from which it will accept and process timing, range and penalty loop data.  
However, due to a change introduced by FileMaker to its Windows runtime version, the arrival of data 
from a timer does not automatically initiate the processing of that data.  Instead, the operator must 
periodically click on a button to obtain and process the data.  This limitation does not apply if one uses 
a fully-licensed copy of FileMaker Pro v8 (having paid for each copy) instead of the runtime database 
engine, nor does it affect either of the runtime or the fully licensed Macintosh versions of FileMaker.

BIAB v4.2.4 – 15 February 2005

Made a slight change in the Race.JGL file, that affects the way that BIAB interprets data that is 
received from an ALGE 8000 series timer.

Corrected a fault seen when using electronic timing, in that any changes made to Start Times within the 
Competition File appeared to be ignored when using electronic timing, since the original, unamended 
Start Times continued to be displayed in listings of the Competition File.  Now the listing shows the Start 
Times from the competition file, as amended.

No other program functionality is affected.

Updated the copyright notices on the splash screens that you see when starting the program and in the 
‘About Biathlon-in-a-Box’ screen.  The changes are simply cosmetic; in as far as the workings of the 
program are concerned. 

BIAB v4.2.3 – 12 February 2005



Of note to all.  Starting with this version of BIAB, all the BIAB files will be keyed such that they will only 
function with the expected version of BIAB.  You will not be able to intermix files from an earlier version 
with the latest version.  This feature has been introduced to preclude some errors which seem to be 
attributable to having two or more different versions of BIAB installed on the same computer, and the 
apparent mixing of files when the program was running.

Fixed two bugs that appear to have been introduced at version 4.2.

The first was that, when using an electronic timer, any range data that had been entered into the 
electronic file was erased every time that start or finish data was transferred into the competition file.  
The range data now remains intact.

The second was a bug that caused the function of the automatic advance of the starting bib number to 
fail when  the competition file had been accessed after receiving some electronic data.  This 
malfunction reset the bib number to 1 whenever the next data arrived at the serial port after returning to 
the electronic data input window after having viewed the competition file.  This bug also meant that you 
could not enter shooting results while start times were being received and bib numbers automatically 
assigned as a background operation.  These function once again work correctly.

Fixed some text formatting errors that caused some of the text to be cut off when printing Provisional 
and Final Results with some printer drivers.

Made changes in the protocol for processing data from ALGE 8000 series timers, These timers must be 
set to Absolute timing mode for use with BIAB.  The raw times from the Start Channel (C0) and the 
Finish Channel (C1) are used by BIAB, as well as both the Starting Bib Number and the Finishing Bib 
Number, which must be input through the keyboards on the ALGE timer.

The documentation has not been changed, since most of the changes to this version were, in essence, 
bug fixes.

BIAB v4.2.2 – 20 December 2004

Made minor changes in the steps for selecting a Serial Port when connecting the computer directly to 
an electronic timer.  The serial connection is now made earlier in the process, before the actual device 
is configured.

Corrected errors associated with Start Times and with starting lanes in the starting grid that occurred in 
creating Start Lists for Mass Start Competitions.

Introduced into BIAB the ability to use an Excel Spreadsheet to solicit competitor data from clubs and 
teams, and then to import that data directly into BIAB.  This capability should make it easier for 
organizers of large events to get the competitor data entered in a timely fashion, and with enhanced 
accuracy.  After importing the data from the spreadsheet, BIAB will automatically enter each competitor 
in all the competitions that have been scheduled for his/her competitor class, and will also create entries 
in Concurrent Events automatically as well.

Made further minor changes to the way that BIAB works with Summit SRT1000 timers, refining the 
interface, and making it easier to navigate to the different screens used to see the data and to validate 
it.

The documentation of BIAB has been update considerably, to reflect the changes noted above, and 
those that took place in v4.2.1.

BIAB v4.2.1 – 7 October 2004



Corrected some errors in my coding, all of which were associated with the use of the Summit Systems 
SRT 1000 timers with BIAB, and with the processing of the data received from those timers.   No other 
changes were made to BIAB.  The documentation has not yet been updated to reflect those changes.

BIAB v4.2 – 27 September 2004

Major Capability Change

Added the capability to work with the Summit Systems SRT 1000 networkable timer.  This version of 
BIAB will allow communicate with up to six different networked timers, and from those timers can take 
Start Times, Finish Times, the Bib Numbers of finishers, Range data and Penalty Loop data.  These 
timers are manually interrogated from BIAB, when the operator pushes a button, and will them transmit 
any data that has been acquired within the timer since the last time it was interrogated.  In addition, the 
communications protocols that are used with these timers are very robust, with error checking taking 
place with all data that is received from or sent to the timer.

The documentation of BIAB has been updated to reflect the use of the SRT 1000 timers.

BIAB v4.1.2 – 25 April 2004 (not released to the public)

Fixed an issue that was only associated with the use of the ALGE Timy electronic timer with the 
electronic timing interface with BIAB.  There are several different version s of the Timy, that export data 
to the computer’s serial port, but with different lengths of data strings.  The capability has been added 
to BIAB for the user to change the expected string length to match what the timer is producing.

Added a new form, the Protest Form, to the forms and data gathering sheets that can be printed from 
within BIAB.

Made some minor changes to the headers used for Provisional and Final Results, so that the name of 
the Event, e.g. “Arctic Winter Games”, appears in the text printed on the header

Made a minor change in the header of the Bib Sorting List, so that the date modifier, e.g. “in the 
morning”, appears after the date in the header text.

BIAB v4.1.1 – 7 January 2004

Fixed an issue that was only associated with the use of a TAG Heuer electronic timer with the electronic 
timing interface with BIAB.  There were no other changes.

BIAB v4.1 – 20 December 2003

Major Capability Change

BIAB has been modified to incorporate the ability to create and manage Team Aggregate competitions.  
This is a new format of individual competition, with a simultaneous start and which uses the shooting 
rules from the relay competition, i.e. allowing the competitor to hand load and fire an additional 3 
rounds.  This competition has been introduced by Biathlon Canada for the 2003-2004 competition year, 
to replace the relay competition at the Canadian National Championships. 

Minor Capability Change 

Fixed an error that occurred with the Status of Competitors during the transfer of electronic timing data 
to the competition file.  The competitor status was not properly updated during the transfer but the error 
occurred ONLY WHEN there were no Start Times recorded electronically. 

Eliminated the requirement to use the 24U Transcoding Shareware plug-in with the TimeTech Sprint 8 
timer.  A new plug-in called BiaB Support, written by me, and which does not have any additional fees 



associated with it, has been provided which gives the same functionality as the 24U Transcoding plug-
in and which will also support the future use of the Summit Electronic Timing Systems SRT-1000 timer. 

The TAG Heuer CP 705 timer has been added to the list of timers with which BIAB is compatible.  Both 
the CP 705 and the CP 520 produce the same data stream, so no modification of BIAB from version 
4.0 was actually necessary, other than to list this timer amongst the available choices. 

Made minor improvements to the way that starting grid allocations are made in the mass start 
competition. 

Changed the HTML creation capability to show the extra rounds fired at targets in a relay competition.

Changed the HTML creation capability to show the extra rounds fired at targets in a relay competition.

BIAB v4.0 – 30 August 2003

Major Capability Change

BIAB will now interface with a number of electronic timing systems using the computer’s serial port and 
the RS232 communication protocol.  This capability allows for the semi-automatic transfer of data from 
the timing device into BIAB.  A number of the more common timing devices are supported, and more 
can be added upon request.   Notwithstanding this change, BIAB will still work as it always has, with 
timing data being manually entered into the programme through the computer’s keyboard.

The Electronic timing systems currently supported are the ALGE Timy, the ALGE TdC 8000/8001, the 
Chronomix CC737, the TimeTech Sprint 8 and the TAG Heuer CP-520.  At the point of release of this 
version only the TimeTech Sprint 8 has been subjected to extensive testing, since the other systems 
have not yet been available to me to use to actually confirm the functionality of the programming. 
However, the programming should work since it has been tested using the specifications provided by 
the manufacturers of the timing systems.

BIAB has been updated to better meet the changing IBU specifications for the content of printed 
results for competitions.  The largest change is to Relay Competitions, for which BIAB will now permit 
you to account for the extra rounds fired; show the extra shots fired on the results; and show more 
statistics about the performance of the team members.  In addition, the Start Lists for single start 
competitions now display the Grouping assignment of the competitors, when Grouping is applicable to 
that particular competition.

Minor Changes

You may now enter into the BIAB preferences card the URL that you plan to use to post your results.  
That URL will appear in the footer of all Start Lists and Results that you produce with BIAB, telling 
readers where they may look on the Web to find all the results.

BIAB v3.3 – 20 April 2003

BIAB now uses FileMaker 6.0v4.  This change of version of the underlying database software now 
means that BIAB will run and is certified in Windows XP Pro, and older versions of Windows back to 
Windows 95, and will run natively in Mac OS X, in Classic mode under Mac OS X, and in older versions 
of the Mac OS, from v8.6 to v9.2.2.  In addition, whether you use Windows or a Mac OS you will notice 
that when you move the mouse cursor over a button, the shape of the cursor now changes to a button-
pushing hand.

Changed the method by which you create a Bib Sorting List in BIAB.  In previous versions the Bib 
Sorting List was a separate option that could be selected using a button from Lists & Reports within any 
competition file.  In this version, rather than having a separate button for the Bib Sorting List, whenever 
you create a Start List, no matter what type of competition, you will be presented with the option of 



whether or not you want to create a Bib Sorting List as part of the process to preview the Start List.  
The method of creating a Bib Sorting List was changed to present the choice at a more logical point in 
the process of preparing for a competition.

Added an option for Pursuit Competitions that allows you to automatically assign lanes in the Pursuit 
Starting Grid to each competitor.  The software suggests to you the needed number of starting lanes, 
according to the IBU rules.  The Starting Lane that has been assigned is printed on the Start List for 
Pursuit Competitions.  In addition, there is an option for the creation of a separate printed list showing 
the Starting Lane Assignments in the Pursuit Starting Grid.  This capability appears as a selectable 
option after the Start List has been previewed in the actual competition file for that competition.

Added an option for Relay and Mass Start Competitions, to allow you to preview/print a Starting Lane 
Assignment for lanes in the mass start grid.  This option appears when you print a Start List from the 
actual competition file.  In the case in which you have a number of sequential starts, the software 
produces a separate Start Lane Assignment List for each different start time.  In addition, the assigned 
Start Lanes are printed on the Start Lists for Mass Start Competitions.

Changed the assignment of Zeroing Lanes so that you can now assign Zeroing Lanes for Official 
Training Days (or other days if you want) in addition to assigning Zeroing Lanes for Competition days.  
Added a new report option to the Zeroing Lane Allocation process, which permits the creation of a 
printed report that shows only the Club/Team name on the report, rather than listing all the competitors 
by name.

Added a new report in the RELAY_TM.JGL database, which will print a list of the teams that have been 
defined.

Changed the feature that allows you to pre-define Composite Competitions, to allow the association of 
up to four different competitions (rather than just two) with each composite competition.  This will allow 
greater flexibility in composite teams so that more than one competition class, in either or both genders, 
can be specified as eligible to become members of the Composite Competition.

Made several changes to bring BIAB into line with the 2003 edition of the IBU rulebook.  This includes 
several cosmetic changes, such as changing “Start Number” to read “Bib Number” on screens and 
reports, and a major change which was to support the new IBU Pursuit format, which allows the 
organizer to use a Group Start at 5 minutes after the first Single Starts, BUT the IBU rules require that 
the results still reflect the proper Start Time as defined from the Qualifying Competition, not to use a 
reduced or modified Start Time, as is sometimes done in club level races.  The different Pursuit Options 
that existed in BIAB have been slightly renamed, so that a competition with “IBU” in its description uses 
the exact IBU rules, and any competition with “Club” in its description uses modified Start Times to 
create the results

Changed, in the DIURNAL.JGL database, the categorization of non-competition days from “Unofficial 
Practice” and “Official Practice” to “Unofficial Training” and “Official Training” to match the terminology in 
the IBU Rule Book.

In the BIAB.JGL database, fixed the Create Pre-Draw Confirmation Lists reports so that they properly 
display the records and the column titles on the reports.

In the REGISTER.JGL database, increased from 4 to 6 the number of Competitions that can be seen 
on the screen at any point in which a competitor has been entered.  This will reduce the amount of 
scrolling needed to verify that the competitor has been entered in the correct Competitions.

Fixed a small problem in the script that created Grouping Questionnaires.  The script worked correctly if 
the only one set of questionnaires was created, but did not properly correctly calculate the number of 
groups if you tried to create more than one set of questionnaires without first returning to the tabbed 
cards.



Fixed a problem in the REGISTER.JGL database, in the “Registration & Entry Data” window that, under 
certain circumstances, caused the wrong competitions to be selected for a competitor when you mouse-
clicked the button “Add Competitions as Pre-Defined for this Competition Class.”  The error that used to 
occur was, if the Competition Class was “Men”, the competitor would also get entered in “Jr Men” 
competitions, and the same would happen with other similarly named competition classes.

Fixed in the competition files the broken capability to create results for concurrent events.  The 
capability had worked, but had become broken in v3.1.3 and perhaps earlier.

BIAB v3.2 – 18 February 2003

Added the capability to predefine “composite” competitions, which have associated with them two 
different classes of competitors, such as Youth Men and Youth Women.  The two associated 
competition classes will compete together in a mixed gender event such as the Composite Youth 3 x 5 
km Relay.  Predefining the “composite” competitions means that you can easily select these 
competitions for your competitors without having to deliberately change their competition class in the 
REGISTER.JGL database.

Added the capability to perform “wave starts” in relay competitions.  Rather than having a single 
Simultaneous Start, the first members of the relay teams can be grouped, and each group can be 
separately started, after a specified delay, from the starting grid.  This can help alleviate congestion on 
the firing range in situations in which there are far more teams than there are positions on the range.

Added the capability to adjust the length of time that names and numbers of competitors are shown 
during a publicly displayed draw.

Modified the form for the Range Secondary Recorder, to make it far more usable.

Corrected a minor issue to ensure that all records were visible and sorted after using the report feature 
in the EVENT.JGL database.

Updated the documentation to reflect the above and all the changes to this point.

BIAB v3.1.3 – 3 February 2003

Made minor formatting corrections to the data verification forms that can be printed from the competition 
file.  The corrections were to make the forms more readable, and allow all information to be printed 
instead of being cut-off due to lack of space.

In the REGISTER.JGL database, added two new colours for the special bibs worn by the current 
leaders in the North American Cup Series.  The special bib colours for the IBU Youth Men and Youth 
Women are now available.

BIAB v3.1.2 – 22 January 2003

Corrected the problem in which incomplete records would appear in the E_ENTER.JGL database.  
These incomplete records then had to be manually deleted.  Hopefully this change has fully cured the 
issue, which did happen occasionally.

BIAB v3.1.1 – 6 January 2003

Added two new forms.  These are the Finish Line Time-of-Finish Record and the Finish Line Order-of-
Finish Record.  In addition minor changes were made in most of the other forms that BIAB can produce.  
Hopefully the forms are now more useable.

Changed slightly the wording in the warning dialog box that you see when you use the script in the 
Competition File to enter practice data so that you can generate practice results.  All the words are now 



visible on-screen.

To meet the changes in the IBU Rules, changed the designation of “Interim Results” to “Provisional 
Results.”

Added to the Scripts Menu in all Competition Files a new script that will assist you to quickly reassign 
Start Times to any group of or to all the competitors.  Included in this script is the ability to assign pairs 
of competitors the same Start Time, so that you can have the simultaneous start of two competitors, 
then the expected gap to the next pair of competitors.  This feature was added at the request of 
Alberta, and is most likely to be useful when using BIAB for cross-country skiing competitions.

Added to the Scripts Menu in all Competition Files a new script that will assist you to quickly reallocate 
Bib Numbers (Start Numbers) to competitors.  This feature was added in response to a need in Alberta 
to allow the quick re-assignment of sequential bib numbers for all competitors, even when there is a 
significant time gap between competitions, when the automatic draw defaults to a gap in the bib 
numbers that correspond to the time gap.

Added a reminder to the dialog box that appears, during the draw for a Pursuit Competition, when you 
are selecting the type of Pursuit Start that you will use during the Competition.  The reminder is that, 
before the draw, you must select, for each different Pursuit Competition (when you define and describe 
it in the EVENTS.JGL database) an appropriate time interval in the field labeled “Pursuit Cut-Off for 
Group Start.”

Fixed a bug in the REGISTER.JGL database, in that the function of selecting a subset of registrants 
who were on the same Team/in the same Club now works properly.

Updated the manual to reflect the above changes.

BIAB v3.1 – 10 September 2002

Major Changes:

Changed the RELAY_TM.JGL database so that “Teams” can be annotated as “Official” or  “Unofficial.”  
Official Teams are given positional status in results and are awarded World Cup points dependent upon 
their finish position, as related to other teams.  “Unofficial” teams appear in the results, but they are not 
annotated with a finish position, and do not receive any World Cup Points.  This allows composite 
teams of interested athletes to be entered in events, and shows their performance relative to the other 
teams, but clearly indicates that they were “just doing it for the fun” rather than for medals/prizes.

The documentation is now in a fully integrated Adobe Acrobat form with its own electronic table of 
contents, active hyper-links from the table of contents to the appropriate page, and hyper-links on cross 
references.

The documentation has been updated to reflect all the changes and enhancements that have been 
made up to this version and a significant amount of editing has taken place to further clarify a number 
of paragraphs within the text.

Minor Changes:

Changed the name of the database that contains the World Cup Points, from TEMP_PTS.JGL to 
POINTS.JGL.

Modified the TEMP_PTS.JGL database, which contains the World Cup Points, so that the points 
allocation can be changed by a determined user.



Made some changes in the DIURNAL.JGL database to the way that the daily agenda report is 
assembled, and provided more space to enter the data for the time and location of Jury Meetings, 
Team Captain’s Meetings and Awards Ceremonies.

Fixed a bug that appeared in Concurrent Events, in which the final position of Relay and Military Patrol 
Teams was not properly calculated for the Concurrent Event.

Fixed an intermittent but very irritating bug that caused, in a Relay Competition, some competitors’ 
names to be duplicated a number of times in the Competition File.  This bug appeared when a team 
was included in the draw, but no team members had been assigned to that team.

Fixed a bug that caused an incorrect sort order to be used in the E_ENTER.JGL database, when the 
button “Re-Order Competitors to add Group Numbers” was pressed.

Fixed a minor problem in that the names of competitions were sometimes not properly displayed when 
they were being selected from the pop-up menu when performing a team (Relay or Military Patrol) draw.

Corrected a problem in all Competition Files, in which the Club affiliation shown for each competitor in 
Start Lists and Results was not dynamically updated when the club affiliation for that competitor was 
changed in the REGISTER.JGL database. 

Corrected a minor problem in which the Team Start List and the List of Events only showed one record 
on the printed copy, unless you changed the choice in the print menu to “Display all Records.”

Added more levels (changed from 20 to 35) to the pop-up menu choices for the Competition Order-in-
which-to-Start field in the EVENT.JGL database. 

Updated the COMP_CLS.JGL database to reflect the changes to the Biathlon Canada 2002-2003 
categorization of Competition Classes, as announced in June 2002.

Corrected a minor error on the AGENDA.JGL database screen in which the example date did not 
change the display format as dictated in the Date/Time Control Panel setting at the system level.

BIAB v3.0.3 – 31 August 2001

Updated the Comp_Cls.jgl database to reflect the final Biathlon Canada 2001 – 2002 categorization of 
competition classes as announced on 23 August 2001.

BIAB v3.0.2 – 19 August 2001

Fixed a problem introduced in about v2.2 in which the real-time display of a draw with Grouping did not 
appear to work properly.  (NOTE: the results of the Draw were correct, only the display of the draw was 
not properly sequenced)

Minor Changes

Cosmetically changed the Grouping Questionnaire in the E_ENTER.JGL database.  The instructions to 
the Team Captain are now more precise.

Updated the List View Screen in the AGENDA.JGL database to show the correct menu command for 
“Show All Records” for v5 of FileMaker since it changed from v4.

Updated the records in the COMP_CLS.JGL database to reflect Biathlon Canada’s proposal for the 
revised Competition Class names and ages to be used for the 2001/2002 season in Canada.

In the REGISTER.JGL database updated the SCRIPTS that are invoked by the “Add Competitions as 
Predefined for this Competition Class” and the “Add Concurrent Events as Predefined for this 



Competitor’s Team” Buttons.  Now you will be warned if no Competition Class has been chosen for the 
Competitor, no Club/Team has been selected, or there are no affiliated Concurrent Events for the Club/
Team.

The Documentation has been updated to reflect the changes and enhancements.

BIAB v3.0.1  -- 13 June 2001

Major Changes

BIAB now uses v5.0 of FileMaker Pro.  This latest version of FileMaker Pro contains a number of 
enhancements which permit refinement of some of the features within BIAB.  Because of the change in 
the FileMaker version, you must completely reinstall all BIAB files.  It is strongly suggested that you 
delete any previous version of BIAB before you install this new version, in order to eliminate any 
possible adverse affects.

A new database, COMP_CLS.JGL (for Competitor Class) has been incorporated into this version, which 
provides the capability to define the Class of Competitor, link the Class to both the age and gender of 
the competitor, and automatically calculate and display the normal Class of Competitor for each Athlete, 
provided that the gender and birth date are entered.

The Forms view in the REGISTER.JGL database has been completely redesigned to improve the 
speed and accuracy of the entry of Registrant information and to improve the process of Entering 
Competitors in Competitions.  The drop-down menu listing of available Competitions into which the 
Competitor can be entered is now governed by the Competition Class that has been selected for the 
competitor.  This means that the list of available Competitions is much easier to deal with.  In addition, a 
mouse-clickable button has been added, which can be used to Enter the Competitor in all the 
Competitions which have been defined for his or her Competition Class.  For many Events this will mean 
that multiple Entries can be done with one mouse-click.

The suggested Competition Class for each competitor is displayed on the screen for Registering each 
Competitor, but the actual Class assigned to each Competitor is manually chosen by you, so that 
moving up or down in Classes is possible.

To save screen real estate in the REGISTER.JGL database and because it wasn’t being used, the 
Communications information fields for each participant have been removed from the screen and from 
the database.

Eliminated the feature in the EVENT.JGL database that linked a defined Pursuit Competition with its 
defined Qualifying Competition.  This feature was cute from a database geek viewpoint, but did not add 
any usable feature to BIAB, so it was eliminated in order to allow other, more useful features to be 
included in the program.

In the EVENTS.JGL database the means by which you create the name for a Competition has been 
changed.  Rather than the free-form text entry in previous versions of BIAB, now you select the Class of 
Competitor and the Keyword(s) from pop-up menus.  This will help standardize the naming of 
Competitions and should eliminate the possibility of miss-spelling a Keyword.  Sufficient flexibility has 
been retained to allow for distinctly different Events such as Snowshoe Biathlon.

Based upon a number of observations made while BIAB was being used at the Nationals, the process 
of inputting Team Names for Team Competitions and the steps necessary to select members to a team 
in the RELAY_TM.JGL database have been greatly streamlined.  The time and number of keystrokes 
required to name and populate Relay and Patrol teams are greatly reduced.  In addition, two new 
Questionnaires, both related to Team Events, have been introduced.  These are preprinted 
Questionnaires with which the Competition Secretary can solicit information from Clubs/Teams related to 
Team entries.



The actual Draw Process for Relay Team events was been changed so that the software will now 
perform Relay Team draws by two different processes.  If there is Grouping for a Relay, then the Team 
Group Numbers, in the RELAY_TM.JGL database, are used to set the order of draw for Teams.  If 
Grouping is not applicable, then the Competition-Order-of-Start, from the EVENT.JGL database, for the 
particular Competition is used to establish the Draw Order.

The ability to create HTML files from Composite Results for both the primary and any concurrent 
competitions has been fixed, so it now works properly.

Other Changes

A new Tabbed Card, called “Set Preferences” has been added to the stack of cards. This new card now 
provides direct access to set Preferences for the Event, to Define Concurrent Competitions and to 
(Re)”Define Competitor Classes” so that you can make local changes to the gender and age limits and 
the names of the Classes of Competitors used within BIAB.  The defaults provided already match the 
current Classes as set by Biathlon Canada and are matched to the Competitor Classes established for 
Cadet competitions.

A new report, listing all registrants in alphabetic order, has been added to the REGISTER.JGL 
database.

A new form, for use in consolidating firing results on the Range, and for use to record firing results 
passed by radio or land line from the Range to the results preparation area, has been added to the 
Competition File that is generated after the Draw, on the Reports and Lists page.  It is anticipated that 
this will be a very useful form.

The form for Secondary Range Recorder has been significantly changed.  Minor changes have been 
made to several other forms created by BIAB.

The footer of all Lists and Reports has been modified so that the version number of BIAB from which it 
was created is printed on each List or Report.

A number of cosmetic and other changes have been made throughout the application, some fixing 
minor errors but mostly just to improve the appearance of the information presented.

The Documentation has been updated to reflect all the changes and enhancements.

BIAB v2.2.2 – 12 March 2001

Minor changes to some of the reports associated with the Concurrent Events capability that was 
introduced in v2.2.1.

Corrected errors in creating HTML results that were introduced in v2.2.1 when Concurrent Events were 
introduced, and changed the way that HTML results are selected from within the Reports Screen in the 
Competition File.  There is now a selectable option for HTML results which will allow the creation of 
HTML results from all Summary results, including those from Concurrent Events (thanks to Doug 
Swallow for identifying this oversight

Corrected an error in creating HTML results for Relay Competitions.

Corrected error in algorithm to create Start List for a Leveled Pursuit Competition.  It will now properly 
handle a tied Behind Time from the qualifying competition.

Updated the documentation to reflect all the changes in v2.2.1 and in v2.2.2.

BIAB v2.2.1 - 28 February 2001 (Not Released to all users)



Major Change

BIAB will now allow you to identify Concurrent Events, (such as a NorAm Cup which is also a Canada 
Cup which is also an Alberta Cup) and specify the eligibility of each competitor for each of the 
Concurrent Events.  Having done this, BIAB will then produce separate and distinct Composite Results 
for the overall event, and for each of the Concurrent Events, with just a simple selection from a menu.  
This capability has resulted in changes in the BIAB.JGL, the EVENT.JGL, the REGISTER.JGL, and the 
CLUB.JGL databases as well as to the competition file which is created in the Draw process.  It also 
means that an additional database file, C_EVENTS.JGL has been added to the collection of 
databases which make up BIAB.

Other Changes

When Composite Results are created it is no longer necessary to have previously calculated the results 
as either Interim or Final.  The Composite Results function now recalculates all the results each time 
that the button is pushed.

A script has been added to the Competition File which will generate sample firing and skiing results 
which can be used when you are practicing all the functions of BIAB, thereby eliminating the need for 
you to invent data to practice making results and practicing other functions such as creating Pursuit 
Competitions which require a qualifying competition.  This is not a very sophisticated capability, but it 
removes much of the drudgery from practice sessions and testing other functions of the software.

A number of other minor changes have been made, most of which are simply minor changes in the 
format of items that appear on the screen or in reports.

The documentation files have not yet been updated to reflect these new capabilities.  This will be done 
in due course.

BIAB v2.1.1 - 7 February 2001

Major Changes

Made major changes to the way that BIAB handles Pursuit Competitions.  Previous versions were 
limited to Pursuit Competitions which were fully in accordance with the rules for the behind times of 
competitors, with the inter-competitor gap being set by the qualifying competition.  Previous versions of 
BIAB had difficulty processing Pursuit Competitions that contained more than one class of competitor.  
Now BIAB allows multiple classes of competitors in a single file, but will allocate separate start times for 
classes if you wish.  It also gives three choices for the inter-competitor gaps:  the formal gap, as 
determined by the qualifying competition, as set out in the IBU Rules, a "leveled competition" in which 
the order of start is determined by the qualifying competition, but the inter-competitor gap is set at a 
fixed gap, to close up the competitors, and an option in which the gap between the competitors is set 
by the qualifying competition, but over which is applied a cutoff time, after which all remaining 
competitors in that class start en masse.  These changes better accommodate club-level competitions 
by allowing much more flexibility without necessitating the manual modification of Start Times in 
Competition Files.

Fixed a coding error which caused the Draw for a Pursuit to "lock-up" when a certain set of 
circumstances were found in the qualifying competition.

Other Changes

Added to the Pursuit Results a column showing the Ski Time for each competitor.

Modified the Zeroing Lane allocation routines to allow the selection of a limited number of firing lanes 
for use, rather than always having to use lane #1.



Changed some of the algorithms used in Draws to better handle situations in which, in a single 
competition file, the inter-competitor gap was not the same from one class of competitor to the next, 
which resulted in the incorrect calculation of start times.

Added the capability to automatically deal with the coloured bibs worn by the class cumulative-points 
leaders in North American Cup competitions.  The colour of the bib for such competitors appears on the 
Start Lists and Results, having been substituted for the customary start number.

Adjusted the space available for viewing and printing the abbreviations for teams on start lists, results, 
and reports, to allow longer abbreviations to be viewed.

Added a button to the "Well in Advance of the Competition" card to allow direct access to the 
CLUB.JGL database for entering and editing Club/Team names and abbreviations.  This will encourage 
getting these set up in advance, and putting some thought and rigor into the Team Names and 
abbreviations.

Fixed a problem in Competition Files which caused the Club affiliation of a new record (manually 
created) to not be shown on-screen or in reports.

Changed the way that BIAB links other databases to the trails described in the COURSE.JGL 
database.  Now each trail has a reference number.  This means that you can have trails in different 
locations, but with the same colour of marking, such as Red, and BIAB will correctly calculate the total 
competition distance when defining competitions in the EVENT.JGL database.  Also updated the trails 
report to show the word "km" to qualify the length of each trail.  You no longer have to type in the units 
for the Distance field, but a unit of measure is still need for the fields describing climbs.

Updated the manual to correct errors and omissions and to reflect all changes introduced in v2.0.3 and 
v2.0.4.

BIAB v2.0.4 - 19 January 2001

Fixed a minor and irritating problem in which the menu selection choices for Pre-Draw Confirmation 
Reports (in the E_ENTER.JGL database) were not necessarily up-to-date if changes had been made in 
the titles of competitions after competitors had already been entered in those competitions.

Added to a number of the pre-draw confirmatory and grouping reports/questionnaires the logo of the 
event organizing group and the logos of sponsors.

BIAB v2.0.3 - 17 January 2001

Corrected errors which occurred when creating Start Lists and Results from within Competition Files for 
Relay Competitions which featured more than one class of competitor within the same event.

Made significant revisions to the steps necessary to complete draws for Team events, and to ultimately 
create a competition file after having completed the draw for team start order.  The process is now 
somewhat less confusing.

Updated a number of links between data bases to take allow the data to be properly updated with only 
a single entry in the master data base.

Made minor changes in a number of reports, especially those relating to team events, to provide more 
information, and to sort the information presented in a more logical manner.

Removed background shading from some of the boxes on some of the forms to reduce the obscuration 
that the shading was causing to light pencil entries on the forms when they were being used.

Fixed a number of minor field linking problems on selection screens related to team events, which were 



apparent by a <field missing> notice being given.

The documentation has not yet been amended to reflect these changes, but amended documentation 
will follow shortly.

BIAB v2.0.2 - 28 November 2000

Updated to correct a minor fault, introduced in v2.0.1, on the cover sheet for final results, in that the 
officials and TD were not actually named on the cover sheet due to a mis-linking of data bases.

Updated the World Cup/North American Cup Points System which shows points on results to reflect the 
increased points allocation that has been introduced for the 2000/2001 Competition season.  First 
place is now awarded 50 points vice the previous 30, and points are now awarded to 30th place, rather 
than 25th place.

Also made minor change to the DIURNAL.JGL database, so that only two meetings of the Competition 
Jury are scheduled rather than three.

BIAB v2.0.1 -- 14 June 2000

MAJOR CHANGE #1

Added the capability for all BIAB functions to use a level of timing precision down to the nearest one-
tenth of a second, and to cause that level of precision to appear in all the results.  This capability need 
not be used, and there is an separate capability to suppress the appearance of the decimal seconds in 
the results, so they don't look strange when that capability is not used.

MAJOR CHANGE #2

Changed the format in which BIAB accepts time data into the competition file.  In previous versions it 
was necessary to format the data, separating hours, minutes and seconds with a colon.  Now the digits 
for the time entry can simply be typed without any special formatting, and BIAB will accept them. This 
will save at least two shifted keystrokes for every time entered.

OTHER CHANGES

Updated the Documentation to reflect this version and all the changes.

Changed the Agenda form to add an Agenda Item which is the "Coordination of Use of Radio 
Frequencies" so that conflicts for use of FRS radio frequencies can be avoided.

Added a printable form for recording the results of the equipment inspections.

Changed the way that dates for competitions are managed within the application, such that competition 
dates are now fully relational between the files.  This means that they can be changed at the single 
source and the change is reflected throughout the application.  This should avoid the kind of problem 
that was experienced by some users when they entered an incorrect date, and then tried to amend it 
after the draw was completed, which caused misinterpretation of the date.  This change should also 
simplify the 'after the event is over housekeeping chores,' since, if a date/agenda record is deleted, all 
competitions and entries for that date will be automatically deleted as well.

Cosmetic changes to the appearance the cards in the BIAB.JGL database, and to all the screens in a 
competition file.

Added, in the Event.JGL database, the geographic locations of the trails and the distance of the trails, 
both of which are displayed on the pop-up menu from which you select the colour for each trail to be 



skied in the competition.

Added to the Grouping Questionnaire the ability to manually specify the number of Groups that there 
will be, in case you want to over-ride the IBU established criteria.  At the same time I made cosmetic 
changes to the associated dialog box.

Added the capability to optionally accept and compute results using timing data in the form of Start and 
Finish Times or in the form of a pre-computed Ski Time.  The latter is the preferred output format from 
more advanced (and expensive) stand-alone electronic timing systems.  Using Ski Times in BIAB does 
save some data entry effort.

Added the capability to quickly Export and Import files of timing information, specifically Start Times, 
Finish Times and Ski Times.  These files allow three computers to be configured with identical versions 
of BIAB, and then each used for a portion of the data entry.  Then the exported data files are imported 
into one of the computers to generate results.  This should allow the timely handling of larger 
competitions.  The export can be on floppy disk, or over a small network established for that purpose.

Added World Cup Point allocation capability, so the points awarded appear in the printed results for 
each deserving competitor or team.

Cosmetic changes to the Club Details screen in BIAB.JGL/Set Preferences for the Event.

Changed the display of the date of a competition in the Event.JGL database, so there is less confusion 
between days and months, and which is which.

Added the capability to generate random numbers, as a choice on the "Preparing for the Team 
Captain's Meeting 2" card.  You can use these random numbers for a simple draw, such as for 
assignment of team rooms, or any other similar purpose.

Added to the List View in the Event.JGL database, the ability to sort the records by "Type of 
Competition" so, for instance, all "Sprint" competition entries will be listed together.

Changed the automatic formatting for displaying competitors names in printed reports and elsewhere.  
Family names are displayed as all upper case, and now, given names with the first letter capitalized, 
then the remainder of the given name(s) in lower case.

Corrected the logic that is used to take you to the Reports window in the Register.JGL database, and 
then, when finished with the reports, to return to the correct screen and database (either Biab.JGL or 
Register.JGL) from whence you came in the first place.

Corrected an error that sometimes caused an apparent lock-up of the screen when you attempted to 
create a Grouping Questionnaire.

Fixed errors in the Mass Start Composite Results to properly display results from all four bouts of 
shooting, rather than just the first two.

Fixed an obscure error in the compilation of Results for Relay Competitions and for Military Patrol 
Competition that would not properly account for imposed penalties under some circumstances.  In 
addition there is no longer a requirement to enter all penalties and adjustment times for a Patrol 
competition against the Patrol leader.  Penalties and adjustments can now be entered and will be listed 
against the responsible team member.

Made changes to the appearance of the Form and List Screens related to Military Patrol Competitions.  
The advisory notes for Patrol Competitions only appear on-screen for Patrol competitions, and not 
during other types of competitions.



Made minor format changes for the Start List, Results and Composite Results for Relay and for Military 
Patrol Competitions, so show the Club/Team affiliation of each team member.

Fixed a minor problem which caused the incorrect printing date to be displayed at the bottom of the 
Daily Agenda report.

Fixed a minor typographic error which referred to the date selection menu when creating an Agenda for 
a Team Captain's Meeting.

BIAB v1.7.3 -- 5 Feb 00

Updated the Documentation File to reflect this version, and the added capability of the Recover 
command.

Added an HTML Formatted Report specifically for Cross Country (Keyword XC) competitions, so that no 
shooting results appear in the report.

Added to the BIAB.JGL database (all the tabbed cards) a script that can be run from the SCRIPT menu 
so that you can attempt to repair damaged database files using the FileMaker Pro "Recover" command.  
You will know if you need to use this capability because BIAB will refuse to read a particular database 
file, and will advise you in a dialog box to attempt to repair it using the "Recover" command.

Fixed an error in the E_ENTER.JGL database in the screen used to filter the entries, to restore full 
functionality, part of which did not work after the introduction of v1.7.1.

Fixed an error that appeared in the Draw routine which prevented it from properly processing Draws with 
Grouping.  In this error, which was probably introduced in v1.7.1, Grouping was ignored during the draw 
for all non-team competitions. This repaired file is TEMP_S.JGL.

Fixed the routine that created the Team Order Start List after a draw of Teams for the Team Order of 
Start, so that it sorts the teams properly, by order of Start Number. This repaired file is TEMP_T.JGL.

BIAB v1.7.2 -- 16 Jan 00

Updated the Documentation file to reflect this version and to correct some errors/poor explanations in 
the v1.7.1 version.

Fixed an error that was introduced into v1.7.1 in which the Grouping Questionnaires and the preDraw 
Entries Verification List would no longer function properly.

Reformatted all reports to give a one-half in top and left margin to the printed reports.

Added the capability, within the Competition file which you generate in the Draw process, to print a Trail 
Order "Poster" which is intended to be posted near the Start Line so that the competitors can have one 
final verification of the sequence of trails that they are to follow.

Added the capability, on the 'Before the Team Captain's Meeting' to create a standardized Agenda for 
the upcoming meeting.

BIAB v1.7.1 -- 28 Dec 99

Several changes were made throughout the documentation to correct errors, to reflect the changes in 
format and content to screens, and to describe some of the features of the new capabilities that have 
been added and are described below.

Added support for Assigning Zeroing Lanes to Clubs/Teams, on a random selection by Club/Team, and 
then to print out Zeroing Lane Assignment Listings, to indicate the assignment.  In some cases manual 



fine tuning is necessary to augment the automatic process, to complete the assignment, since the 
programming necessary to do everything automatically would have been a prohibitive overhead.  The 
manual fine tuning is fast and easy, and it can also be used to over-ride some of the assignment that 
was done automatically.  Access to this capability is by button from the "Preparing for the Team 
Captain's Meeting" tabbed card.  Right now it works for just Individual and Sprint Competitions.  Zeroing 
Lane Assignment support for Pursuit, Relay, and Military Patrol competitions may be added at a later 
date.

Eliminated three fields in the EVENT.JGL database, the three "Is the competition a ...." fields are the 
ones that were eliminated.  The function is now performed by additional programming to parse the 
Competition Descriptive Name for appropriate Key Words.

Added a new report, Bib Sorting List, to the Competition File. This report, which is run after the Draw, 
produces a printed listing of all the Bib Numbers for the competitors, sorted by Club/Team, and can be 
used to help sort the Bibs for distribution to Teams.

Added a new report which is a listing of the attributes of the trails that are to be used for the 
competition.  

Revised the screen layout in the Forms View in Competition Files, to provide labels for all fields that are 
present, to cause less confusion.

Made several changes to the data structure used within BIAB so that the Competition Name, 
Competition Order-of-Start, Club Name and Club Abbreviated Names are consistently presented as 
Relational Fields, and will be properly updated whenever a change is made in the EVENTS.JGL 
database or to the CLUB.JGL database.  In addition, the Competition Name and Competition Order-of-
Start are now linked in the Competition File, so they will always stay 'in-sync' if manual editing is 
performed upon the Competition File.  This structure change should eliminate some of the occasional 
aberrations in Results listings that had been reported, and which were causing frustration.

Added a report Team Registration and Entries Confirmation, accessible from the RELAY_TM.JGL 
database.

BIAB v1.6.5 -- 9 Dec 99

Minor cosmetic change to the "About Biathlon-in-..." screen to better support the Macintosh version.

Minor changes in format of the confirmation report of competitors entered by team, and the 
competitions in which they are entered.  The report is entitled E_Enter/Register by Team.

Shortened the time during the Draw that each competitor's name and then assigned start number is 
displayed.  This change may only be noticeable on very fast computers.  The shortened time is 
intended to give a 1 second exposure, versus the 2 second exposure that was used in all previous 
versions.

Fixed (I hope) an intermittent problem in the E-ENTER.JGL database of the machine locking up when 
attempting to select competition names in order to display and print Pre-Draw Confirmatory lists, in 
preparation for the Team Captain's Meeting.

Minor cosmetic changes to a number of dialog boxes in the E_ENTER.JGL and the REGISTER.JGL 
databases, to make the buttons and the information text that is presented more readable on screen.

Changed, in the EVENT.JGL database, the sort order for the Report on Types of Competitions and 
their details, so that the sort is now by Date and then by Competition Order-of-Start, to make it easier to 
verify details for scheduled competitions.

Changed the calculations of Start Numbers and Start Times during the Draw in order to eliminate errors 



which occurred when the Inter-Competitor Gap was set to 0 seconds and there was more than one type 
of Competition running in series from a single start time.  The Draw process now gives the correct Start 
Numbers for Mass Start and other Competitions which contain more than one Class of Competitor.  This 
change allows you to create a Competition File which contains a series of mini-mass start competitions, 
with each different type of competition (Men's, Women's, etc) having its own mass start time.  This new 
capability will be referred to in the Documentation as the "Sequential Mini-Mass Start," or the "Hay River 
Sequential Mass Start," to acknowledge its origin.  The "Hay River Sequential Mass Start" is achieved 
by using an Inter-competitor Gap of 0 seconds, and a Gap between Competitions of the desired 
difference in Start Times.  This capability should not be confused with the "Group" start, which is 
formally defined in the Rule book, requires the use in BIAB of the Key Word "Group" and requires that 
grouping has been defined and set, that the Inter-competitor Gap is set to 0 seconds, and optionally 
can work with putting gaps between types of competitions (Jr Men, Jr Women, Men, Women, etc) if the 
Gap Between Competitions has also been defined.

Fixed a problem on a number of reports in which the date printed was not shown as part of the footer 
on the report.  This problem may still exist on some Reports, and I would appreciate knowing which 
ones, so that they can be fixed too.  The name of each Report should appear on the Report, as part of 
the footer text, so they can be positively identified this way.

Deleted the Script in several of the databases that deleted all the current records and imported 
additional records from other databases.  This was done because the script was inflexible.  Importing as 
a function is available through the File menu, so the same objective can still be achieved.  In the future 
this capability will be covered in the documentation.

Added to all competition output forms (Start Lists, Interim Results, Final Results and Composite Results) 
the time and date that they were printed.

Added forms for Secondary Range Recorders (Bibs 1-50 and Bibs 51-100) and a form for the Range 
Controller.

Fixed the 'Licensed by ..." screen so that the required action would be more obvious and made minor 
appearance changes to the screen.

Added more detail to the Biathlon-in-a-Box Documentation, to cover more features, including some in 
v1.6.5.  However, the documentation is not yet complete.

BIAB v1.6.4 -- 27 Oct 99

Significantly updated the Biathlon-in-a-Box Instructions, which are available for downloading from the 
BIAB distribution site, as an Adobe Acrobat PDF file.  The instructions are now about 90% complete, 
and cover most of the features of BIAB.  If you do not have the free Adobe Acrobat Reader, you may 
download it and use it for free. The Adobe URL is <<http://www.adobe.com>>.

Cosmetic changes to the tabbed index cards "At the Team Captains' Meeting" to change the 
appearance of the buttons to choose either Individual or Team type of competition.

Fixed an error in the Draw for Pursuit competitions which caused an apparent lock-up during the Draw 
process that occurred if there were fewer registrants in the E_Enter database than there were 
competitors who had competed in the qualifying competition.

Cosmetic changes to the Details of Competitions Report in the EVENT.JGL database.

Changed format of the Results for Pursuit Competitions to show the Final Time for each Competitor, so 
they will know how they performed in an absolute sense, not simply relative to the winner.



Added special Start List and Results Forms for Cross-Country (keyword "XC") Competitions, so that 
there is no reference to shooting in any of the printed outputs for such a Competition.

Added the capability to generate HTML files of Composite Results, so that the Results can be uploaded 
easily on the World Wide Web and/or viewed with any Web Browser.  The output of this BIAB function is 
an HTML Table(s) which contains all the important Results information, in the some order-of-
Competitions as the printed Composite Results, showing the Results for all the different Competitions 
that are contained within the original Competition File.  The resultant HTML File can be used as-is, or 
edited with an HTML editor to add additional information that might be useful to the viewer.  This new 
capability is accessed directly from the Competition File under the Reports & Lists capability.  For 
Competitions for individuals one HTML file is generated, which contains all the results.  For Competitions 
for teams, that is for Relay and for Military Patrol Competitions, two HTML files are generated for each 
competition.  One contains the overall results for each team, and the second contains the performance 
data for each member of all the team.  The files had to be split this way since FileMaker will not 
generate a single HTML file that contains both the team and individual performance results.

Fixed the error in the calculation of the results of Pursuit Competitions.  This error, which existed in all 
versions prior to v1.6.4, deducted the Pursuit Start Time from the Finish Time, and calculated the results 
accordingly, rather than using just the Finish Time, which must be used for Pursuit Competitions.  

BIAB v1.6.3 -- 31 Aug 99

Cosmetic changes to the screens used to define Relay and Military Patrol Teams, and then on the 
screens used to select Competitors to those teams.

BIAB v1.6.2 -- 15 Jun 99

Set BIAB to take its date formatting instructions, for entry of dates (as dd/mm/yy or mm-dd-yy, etc) from 
the Operating System settings, as established by the relevant Windows or Mac OS Control Panels.  The 
format that is in use is displayed within the affected Windows.  To use this feature the option "Use 
System Formats" must be selected in the "Format" menu of BIAB.

Cosmetic changes to the event description and competitor registration screens, and to the set-up 
screen in BIAB, to advise how to change the date entry format.


